Table of Contents

INTRODUCTION TO FINANCIAL ANALYSIS HANDBOOK CLASS ......................................................3

OVERVIEW .........................................................................................................................................................5
    WHAT IS FAH?...................................................................................................................................................5
    MINIMUM HARDWARE AND SYSTEM REQUIREMENTS FOR I-SITE AND PA ...............................5
    OTHER COMPATIBLE SOFTWARE TOOLS....................................................................................................5
    COPYRIGHTS.......................................................................................................................................................6

GETTING STARTED WITH I-SITE .......................................................................................................................8
    LOGGING ON ......................................................................................................................................................8
    UNDERSTANDING THE INTERNET AND BROWSERS ..............................................................................9
    NAVIGATIONAL TOOLS AND BUTTONS .......................................................................................................9

SEARCHING FOR ENTITIES...............................................................................................................................11
    FINANCIAL FIRM SEARCH.............................................................................................................................11
    MULTIPLE CRITERIA.........................................................................................................................................12
    EXAMPLE – SEARCHING FOR A COMPANY (FIRM).....................................................................................12
    THE LOOKUP RESULTS PAGE ..........................................................................................................................13

LESSON #2: FAH REPORTS.................................................................................................................................15
    FINANCIAL ANALYSIS HANDBOOK ...................................................................................................................17
    SECTIONS OF THE FINANCIAL ANALYSIS HANDBOOK ........................................................................17
    SAVING REPORT DATA ..................................................................................................................................20
    PRINTING REPORT DATA ...............................................................................................................................23
    PROGRAM AUTOMATOR CHECKLISTS IN I-SITE.......................................................................................23

LESSON #3: USING PROGRAM AUTOMATOR...................................................................................................27
    GETTING STARTED ...........................................................................................................................................27
    CREATING A NEW ANALYSIS .......................................................................................................................28
    IMPORTING DATA INTO PROGRAM AUTOMATOR.....................................................................................33
    ATTACHING OTHER DOCUMENTS .................................................................................................................36
    PRINTING A DOCUMENT ...............................................................................................................................40
    BUILDING CUSTOM REPORTS ......................................................................................................................41
    RESUME AN ANALYSIS ..................................................................................................................................45
    MODIFY ANALYSIS - ADDING CHECKLISTS ...............................................................................................46
    SETTING DEFAULTS .......................................................................................................................................50
    PREFERENCES ...................................................................................................................................................52

APPENDIX A: REPORT HARD COPIES ............................................................................................................55
During this “hands-on” class instructors will guide students through the process of using the I-SITE Financial Analysis Handbook and Program Automator. In addition to formal classroom instruction on each topic, exercises will be worked together as a class. Students will then have the chance to work independently on exercises to reinforce skills. Students are expected to actively participate in discussion and during the exercise sections of class.

“Lecture: Going from the notes of the lecturer into the notes of the students without going through the minds of either.”

Taken from: ‘Pi In The Sky: Counting, Thinking & Being’ by John D. Barrow
This page is intentionally left blank
Overview

What is FAH?

Financial Analysis Handbook (FAH) provides reports to assist financial analysts in the analysis process. I-SITE is an Internet-based interface used to obtain data available from the NAIC database. FAH also uses a third-party software tool called Program Automator. Program Automator puts the information from FAH into various checklists that can help analysts determine financial information about a company.

The Financial Analysis Handbook was developed under the direction of the NAIC’s Financial Analysis Working Group beginning in 1994. The initial draft was composed by consultants under the overall direction of the working group and with considerable assistance by working group members and other regulators. Pilot programs (field testing) held in 1995 and 1996 provided the working group with a comprehensive understanding of the needs and concerns of potential FAH users. The product released reflects the feedback, where practical, from Pilot participants. The feedback addressed both analytical issues and software capabilities.

The handbook is available in separate life-health and property-casualty editions and is a tool to assist the analyst in conducting a comprehensive financial analysis of an insurance company, particularly multi-state domestic companies. Each handbook contains background information, reference material, and other tools designed to help the analyst investigate the financial records of a company.

The purpose of the FAH is to aid department analysts in performing financial analysis of insurance companies. It is an educational tool, as well as an electronic means for performing analysis. The educational component consists of a hard copy manual that includes Introductory Chapters, a Financial Analysis Framework Chapter and Analyst Reference Guides. The Introductory Chapters include topics such as Interstate Communication, External Information Sources, SAP -vs.- GAAP and other topics. The Financial Analysis Framework Chapter provides an overview of the financial analysis process. The Analysts Reference Guide provides background information and explanations of analytical procedures. Analysis itself is performed utilizing checklists. The checklists are available in both hard copy and electronic forms. The educational component is in hard copy form only. Each FAH report generated from I-SITE provides answers to the questions on the checklists for a specific company. To be useful to the analyst, the information on the reports must either be matched to the questions in the hard copy manual or imported to Program Automator.

The checklists are the basis of the FAH. Multitudes of checklists are available on topics ranging from investments to reinsurance to affiliated transactions and many more. The checklists extensively utilize ratio results to flag areas where concerns may exist. The FAH electronically calculates these ratios, and if Program Automator is used the results are imported into the checklists, saving the analyst considerable time and effort.

Minimum Hardware and System Requirements for I-SITE and PA

Like most Windows products, I-SITE works best on a Pentium computer with 32 Mb of RAM. The minimum specifications are listed below:

- 586 IBM PC or Compatible with VGA monitor
- 32Mb RAM
- Mouse
- Windows 95/98/NT
- Internet Browser – Netscape or Internet Explorer (4.0 or greater)
• Install Plug-in – enables financial report generation
• 25Mb hard disk space
• TCP/IP connectivity

State offices that use Microsoft Excel as their spreadsheet software tool can use I-SITE to load financial data directly into Excel Spreadsheets. To do this, the location of the Excel executable file must be in the path statement of the AUTOEXEC.BAT file. For more information, contact the NAIC Help Desk at (816) 783-8500.

If you are using Program Automator, it is important to realize that the report generated from I-SITE, must correspond to the checklists available within Program Automator. If the checklists do not correspond to the report, you will not be able to successfully import the data results.

Other Compatible Software Tools

Data presented by this software is fully compatible with most Windows-based spreadsheet or word processing software. Special functions, like the ability to create Microsoft Excel spreadsheets automatically, may require special settings in the system configuration.

Copyrights

The FAH is a copyrighted document and may not be copied, either in part or in its entirety, for use outside of your department. For departmental use only, feel free to make copies of the hard copy version. The software version is licensed to the NAIC by an outside vendor and may not be duplicated.
I-SITE is an Internet browser-based version of the Common User Interface (CUI). I-SITE is used to obtain financial, market conduct and producer licensing information housed in the NAIC data tables. The first lesson covers basic use of I-SITE, including:

- Logging into the System
- Understanding the Internet & Browsers
- Navigational Tools & Buttons
- Using Search Criteria
- Viewing Lookup Results

**Logging On**

Activate your Internet browser (either Netscape or Internet Explorer – 4.0 or greater). Navigate to the URL for I-SITE’s Log-in page. (http://i-site.naic.org/isite)

Enter your I-SITE User Name and Password. The system automatically defaults to the last User Name entered.

Like most logins, the User Name and Password are case sensitive. The User Name format is the first letter of your first name followed by your full last name in proper case. As an example, “TTrain” is the name of a user whose true name could be Tim Train. Initially, the Password for all users is set to “password” (lower case), but after you have logged into I-SITE, you are prompted to change the password. Many errors related to entering the User Name and Password are a result of not using the proper case or having CAPS LOCK turned on. Asterisks will mask the entry of your password for security purposes.

If you do not have an I-SITE User Name, contact the NAIC Data Processing Coordinator in your state. The NAIC DP Coordinator is also responsible for resetting passwords.

Once the appropriate User Name and Password are entered, click the drop-down arrow associated with the Category region.
From the Category list, you will select the type of search necessary to obtain the required information. To obtain a list of companies (or firms) from which to obtain their financial data, you can select the Financial Firm Search or Market Firm Search options listed. (NOTE: To obtain the financial data for one company and you know the NAIC Company Code (CoCode), select the Quick Financial Reports option.)

Once you have entered your User Name, Password and have selected the appropriate category, click the Log-In button on the page.

**Understanding the Internet and Browsers**

Although it is easy to confuse the Web with the Internet, they are not the same. The Web is only part of the Internet and with the help of a browser, you are able to access the various parts of the Internet.

Both Netscape and Internet Explorer are Web Browsers that can be used to access the I-SITE applications. Browsers are programs that establish a connection to a Web site, read documents or other data, and display documents or data according to predefined format conventions.

To locate web sites you will need to identify the URL or Uniform Resource Locator. These URL’s or web addresses provide the type of format being used and where the information is located. Be sure to enter them exactly as they appear – both the path and file names are case sensitive. Example: sourcetype://hostname/path/filename. The 3-character suffix in the host name helps to identify the kind of organization operating the Web site server. Some common suffixes are: .com (commercial), .edu (educational), .gov (government), .mil (military), .net (networking), .org (non-commercial).

**Navigational Tools and Buttons**

**Forward/Back** – Click the “Forward” button to display the next page in the history list. This button is available only after you have used the “Back” button or have historical items available. Click the “Back” button to display the previous page in the history list. When the “Back” button dims and becomes unavailable, you are viewing the first page or the location you began navigating from. To navigate more than one page back or forward, click the drop-down arrow next to the button, then select a page listed.

**Stop/Reload or Refresh** – To stop a page transfer in progress, click the “Stop” button. Clicking the “Reload” or “Refresh” button will redisplay the current page. This will enable you to see any changes made since the original page was loaded.

**Home** – Click the “Home” button to display the page you have designated as your home URL. This designation is made through the Properties/Preferences dialog box of your browser, which is located under the File or Edit menus.
**Increase/Decrease Fonts** – From the View menu, select the Font control option to change the text attributes on the page. *(Note: Data displayed on the Financial, Securities and Subsidiaries reports can not be modified.)*

**Hypertext Links** – Connections that are made between words, pictures, or informational objects to other objects are considered to be Hypertext links. In a multimedia environment, such as the World Wide Web, these objects can include sound and motion video sequences. The most common form of link is the highlighted word or picture that can be selected by the user (with a mouse or in some other fashion), resulting in the immediate delivery and view of another file. Within I-SITE the use of Hypertext Links are provided as blue-underlined text.
Searching for Entities

When searching for entities, you will begin by selecting the appropriate search page available within I-SITE. Selection of the search page can be done prior to Log-In or by using the various links provided at the top of any Search page. The Financial Firm Search page is displayed below.

<table>
<thead>
<tr>
<th>Field</th>
<th>Financial Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year</td>
<td>1998</td>
<td>Year for lookup.</td>
</tr>
<tr>
<td>Company Code(s)</td>
<td></td>
<td>Comma-separated list of 6-digit company codes.</td>
</tr>
<tr>
<td>Company Name(s)</td>
<td></td>
<td>Comma-separated list ofFavorite names of the NAIC company names.</td>
</tr>
<tr>
<td>FEIN(s)</td>
<td></td>
<td>Comma-separated list of Federal Employer Identification Numbers.</td>
</tr>
<tr>
<td>Group Code(s)</td>
<td></td>
<td>Comma-separated list of NAIC group code.</td>
</tr>
<tr>
<td>Filing Type</td>
<td></td>
<td>Consolidated companies are commonly called “groups”.</td>
</tr>
<tr>
<td>Business Type</td>
<td></td>
<td>Most reports are for Life and Property businesses.</td>
</tr>
<tr>
<td>State</td>
<td></td>
<td>State for lookup.</td>
</tr>
<tr>
<td>Licensed in state</td>
<td></td>
<td>State assigned indicator.</td>
</tr>
<tr>
<td>Business Written</td>
<td></td>
<td>Schedule T non-zero indicator.</td>
</tr>
<tr>
<td>Filing Status</td>
<td></td>
<td>Filing status indicator.</td>
</tr>
</tbody>
</table>

**Search Criteria and Descriptions**

Once the search category is chosen, specific input fields appear on the Search page. These fields allow you to define specific requirements that are known about the companies being analyzed (e.g. All Firms Domiciled in the State of Missouri). To define the specific criteria, locate the field(s) in the left column of the table and enter or select the criteria within the associated input field (in the middle column). If you are unsure of a field’s use, click the field name hypertext link and its definition will be displayed.

Once you have entered all the criteria, click any “GO” button located in the description field (right column) or click the “View…” button located at the bottom of the page. Should you need to reset or clear all the criteria entries made, click the “Clear” button located at the bottom of the page.
Searching for Entities

To display more than 5 entities per page on the Lookup Results page, select another option from the “Display Rows” drop-down list. To change the sort of the entities displayed on the Lookup Results page, select another option from the “Sort” drop-down list.

Multiple Criteria

Several input fields will allow you to type multiple criteria. In order to use multiple criteria, separate the entries by a comma (no space is needed). When the input field uses a drop-down arrow for selection, you are limited to one criteria selection for that field.

(NOTE: When using several different field criteria for a search, it is important to remember that all field criteria conditions must be true to display accurate results. An example: Company Name = Prudential, Business Type = Life, would display only those companies whose name begins with the word “Prudential” and whose statement type is Life information.)

Example – Searching for a Company (Firm)

Below is an example of a search on the Financial Firm Search page using the Company Name field with the criteria of “Prudential”.

<table>
<thead>
<tr>
<th>Field</th>
<th>Financial Input</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year:</td>
<td>1980</td>
<td>Date for lookup.</td>
</tr>
<tr>
<td>Company Code(s):</td>
<td></td>
<td>Comma-separated list of 5-digit company codes.</td>
</tr>
<tr>
<td>Company Name(s):</td>
<td>Prudential:</td>
<td>Comma-separated list of beginning letters of the NAIC company names.</td>
</tr>
<tr>
<td>FEIN(s):</td>
<td></td>
<td>Comma-separated list of Federal Employer Identification Numbers.</td>
</tr>
<tr>
<td>Group Code(s):</td>
<td></td>
<td>Comma-separated list of NAIC group codes.</td>
</tr>
<tr>
<td>Filing Type:</td>
<td></td>
<td>Consolidated companies are commonly called “groups”.</td>
</tr>
<tr>
<td>Business Type:</td>
<td></td>
<td>Most inputs are for Life and Property businesses.</td>
</tr>
<tr>
<td>State:</td>
<td></td>
<td>State for lookup.</td>
</tr>
<tr>
<td>Licensed in state:</td>
<td></td>
<td>State assigned indicator.</td>
</tr>
<tr>
<td>Business Written:</td>
<td></td>
<td>Schedule T non sure indicator.</td>
</tr>
<tr>
<td>Filing Status:</td>
<td></td>
<td>Filing status indicator.</td>
</tr>
</tbody>
</table>
1. Click in the Company Name(s) input field and type the word prudential.  (NOTE: I-SITE is not case sensitive.)
2. Click any GO button listed in the Description column or click the View Entities button located at the bottom of the page.
3. The results of your search criteria will be displayed on the Lookup Results page as shown below.

The Lookup Results Page

Once the search criteria have been entered/selected, the resulting list of entities matching the criteria is displayed on the Lookup Results page.

<table>
<thead>
<tr>
<th>Company Name</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRUDENTIAL ASR CO</td>
<td>Complaints, Directors and Officers, Exam Tracking, Financial, Regulatory Actions, Relationships, Special Activities</td>
</tr>
<tr>
<td>PRUDENTIAL COMMERCIAL INS CO</td>
<td>Complaints, Directors and Officers, Exam Tracking, Financial, Regulatory Actions, Relationships, Special Activities</td>
</tr>
<tr>
<td>PRUDENTIAL DENTAL MAINT ORGAN INC</td>
<td>Complaints, Directors and Officers, Exam Tracking, Financial, Regulatory Actions, Relationships, Special Activities</td>
</tr>
<tr>
<td>PRUDENTIAL GENERAL INS CO</td>
<td>Complaints, Directors and Officers, Exam Tracking, Financial, Regulatory Actions, Relationships, Special Activities</td>
</tr>
<tr>
<td>PRUDENTIAL HEALTH CARE PLANNING INC</td>
<td>Complaints, Directors and Officers, Exam Tracking, Financial, Regulatory Actions, Relationships, Special Activities</td>
</tr>
</tbody>
</table>

Displaying 1 to 5 of 23 Sorted by Company Name.

Should your results include more than 5 entities, you can navigate to the next set of 5 entities by using the navigation button located at the bottom of the list (i.e. First, Next 5, Back 5 or Last).

Should you need to perform a different search, click the Firm Search button located at the bottom of the list and you will return to the previous search page. The Lookup Results page can be printed using the Print button located at the bottom of the page.

By default, the entities listed are sorted alphabetically by Company Name. The sort option can be changed on the Search page by selecting a different option from the sort drop-down list.

Category Applications
To the right of each entity is a list of all the I-SITE applications. The name of each application will appear as a hypertext link. If the name of an application is not displayed as a hypertext link, the NAIC does not have specific data in the application for that particular entity.

By single clicking an application name listed within the Category region, you can launch the specific application and view all available information for the specific entity. For example, to obtain financial reports for a specific entity, single-click the word “Financial” located within the category region for the specific company.

<table>
<thead>
<tr>
<th>Company Name</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>() PRUDENTIAL PROPERTY &amp; CAS INS CO</td>
<td>Complaints</td>
</tr>
<tr>
<td></td>
<td>Directors and Officers</td>
</tr>
<tr>
<td></td>
<td>Event Tracking</td>
</tr>
<tr>
<td></td>
<td>Financial</td>
</tr>
<tr>
<td></td>
<td>Producer Licensing</td>
</tr>
<tr>
<td></td>
<td>Regulatory Actions</td>
</tr>
<tr>
<td></td>
<td>Relationships</td>
</tr>
<tr>
<td></td>
<td>Special Activities</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Code: 32352</th>
<th>Business Type: Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>Entity Number: 00004701</td>
<td>FERIN: 22-2033189</td>
</tr>
<tr>
<td>Group: 304</td>
<td>Domicile: INDIA/IA</td>
</tr>
</tbody>
</table>
This lesson is designed to explain the actual Financial Analysis Handbook sections, how to generate the I-SITE FAH reports, and the process of saving and printing the report data. Topics will include:

- Financial Analysis Handbook – sections
- Generating I-SITE FAH reports
- Download (saving) I-SITE FAH report data
- Printing I-SITE FAH report data

This lesson covers FAH reports for firms. If you are familiar with I-SITE and saving financial FAH reports, skip to the Program Automator lesson.

To access financial report information, perform a Firm Search. Once the firm has been identified on the Lookup Results page, click the “Financial” hypertext link from the category region.

Once the Financial hypertext link is selected, the Financial Reports page is displayed. The Financial Reports page lists the various applications and their corresponding reports available for specific data years. The top region of the Financial Reports page is displayed below.

### Financial Reports

**PRUDENTIAL PROPERTY & CAS INS CO**

- **Corporation:** 32352 GU
- **Entity Number:** 00004701
- **Group:** 004
- **Data Year:** 1998
- **Business Type:** Property
- **FEIN:** 22-2053189
- **Domicile:** INDIANA

**Pick-A-Page**

- HTML

**Submit**

| Number of 1998 reports for 32352 - 463 |

Unless otherwise instructed, use the right mouse button click over the report listings to print or save report data. Do not use the File/Print or File/Save As browser menu item. To view these reports you must have the Powerbuilder report plug-in correctly installed. **Click here** to get the plug-in.
As you scroll down the Financial Reports page, additional applications and the available reports are displayed. The following image displays additional financial applications on this page.

**Profiles**

- Complete Profile
- Financial Summary
- Assets
- Liabilities
- Loss/LAE Reserve Schedule P
- Download report data
- View Report
- Graybar report

Number of 1998 reports for 32352 - 10

**Exam Jumpstart**

- REINSURANCE ASSUMED PROPERTY
- REINSURANCE Ceded PROPERTY
- INVESTMENT CUSIP EXCEPTION - BONDS
- INVESTMENT CUSIP EXCEPTION - PREFERRED STOCKS
- INVESTMENT CUSIP EXCEPTION - COMMON STOCKS
- Download report data
- View Report

Number of 1998 reports for 32352 - 21

You may select multiple reports using the standard Shift-click and/or Ctrl-click window functions.

**Scoring**

- Property Scoring Report
- Property Scoring Worksheet
- Property Scoring Report Quarter 1
- Property Scoring Report Quarter 2
- Property Scoring Report Quarter 3
- Download report data
- View Report

Number of 1998 reports for 32352 - 5

**Exam Team**

- Synopsus Letter
- Exam Designation Report
- Download report data

Number of 1998 reports for 32352 - 2

**IRIS**

- Ratio Results Detail
- Download report data

Number of 1998 reports for 32352 - 1

**FAH**

- A - Level 1 Procedures Checklist
- B - Investments
- B - Unpaid Losses and LAE
- B - Income Statement and Surplus
- B - Risk Based Capital
- Download for Program Automation
- View Report

Number of 1998 reports for 32352 - 33

[Click here](#) to download the Program Automation Checklist and/or the corresponding MS Word document.

**Filing Performance**

- Compliance with NAIC Filing Requirements
- Diskette Errors
- Cross Check Discrepancies
- Variable Line Schedule Errors
- Complete Report

Number of 1998 reports for 32352 - 5

To view these Filing Performance reports you must install a new version of the Powerbuilder report plugin. If you installed your plugin before Version 5.0 of L-SITE click here to go to the download page.
As you continue to scroll down the Financial Reports page, an additional application and the available reports are displayed.

**Financial Analysis Handbook**

Within I-SITE, the Financial Analysis Handbook (FAH) reports provide data to assist the financial analysts in their analysis process. FAH also uses a third-party software tool called Program Automator. Program Automator can import the information from the I-SITE FAH reports into various checklists to assist analysts in determining financial issues or concerns about a company. Please note that the Program Automator software diskettes are mailed under separate cover, and are not considered part of I-SITE. Although current checklists are available within I-SITE, the Program Automator application is not available within I-SITE.

The Financial Analyst Handbook was developed under the direction of the NAIC’s Financial Analysis Working Group. The Handbook is available in separate life-health and property-casualty editions and is a tool to assist the analyst in conducting a comprehensive financial analysis of an insurance company, particularly multi-state domestic companies. Each handbook contains background information, reference material, and other tools designed to help the analyst investigate the financial records of a company.

The purpose of the FAH is to aid department analysts in performing financial analysis of insurance companies. It is an educational tool, as well as an electronic means for performing analysis. The educational component consists of a hardcopy manual that includes introductory chapters, a financial analysis framework chapter and analyst reference guides.

The analysis of the entities is performed using the checklist reports. These checklists are available in the hardcopy form and in electronic form. Each I-SITE FAH report provides answers to several questions on the checklists. To be useful to the analyst, the information on the I-SITE FAH reports must either be matched to the questions in the hardcopy manual or imported to Program Automator.

**Sections of the Financial Analysis Handbook**

The checklists are the basis of the FAH. Numerous checklists are available on topics ranging from investments to reinsurance to affiliated transactions and many more. The checklists extensively utilize ratio results to flag areas of possible concern. The I-SITE FAH reports electronically calculate these ratios, and if Program Automator is used, the results can be imported directly into the corresponding checklists, saving the analyst considerable time and effort.

**Introductory Chapters**
This series of chapters provides general overview information to the analyst and includes topics such as Department Organization and Communication, Interstate Communication and Cooperation, External Sources of Information, NAIC Information, Statutory Accounting Practices Versus Generally Accepted Accounting Principles and Prioritization of Work.

**Financial Analysis Framework**

This is an especially important chapter to the analyst because it describes in detail the analytical framework and minimum financial analysis required. The chapter outlines a recommended approach to using the FAH and in particular the checklists. The analysis of the Annual Statement has been divided into three levels of analysis, as described below:

- **Level 1 Analysis** - assists analysts in identifying areas of concern to determine which areas may need further analysis. As a part of the Level 1 analysis, the analyst will review the NAIC’s FAST and IRIS ratios, as well as the information included in the NAIC’s 5-Year Company Profile Report for the insurer. In addition, the analyst will perform various other general procedures.

- **Level 2 Analysis** - to be performed for those insurers with concerns identified in the previous level of analysis. It addresses topics ranging from investments to reinsurance to affiliated transactions and helps lead the analyst to drawing an overall conclusion on a given topic.

- **Level 3 Analysis** - to be performed for those insurers with concerns identified as a result of completion of the Level 2 Analysis. The Level 3 analysis consists of Supplemental Checklists that reference specific concerns and are designed to assist the analyst in probing more deeply into potential problem areas.

**Analysts Reference Guide**

This section of the Handbook provides narrative information about each financial analysis topic, and is intended to provide the analyst with additional background information if needed during the course of conducting the financial analysis of an insurer. The Analysts Reference Guide chapters are not intended to provide an exhaustive discussion of a particular topic, but rather a concise and practical summary of the relevant issues. Each chapter includes an overview of the financial analysis topic, a detailed discussion of the procedures included in the various checklists, and a bibliography of additional reference sources.

There are two pages for every business type, A and B. Page A contains only 1 report, the Level 1 Procedure checklist. The reports available from Page B vary depending on whether the entity is a property or life company. The checklist process begins with Level 1 Procedures, which aid analysts in identifying areas of concern to determine which areas may need further analysis. After completing Level 1, the analyst may opt to complete as many of the Level 2 (Page B) checklists as deemed necessary. Level 2 checklists address topics ranging from investments to reinsurance to affiliated transactions and help lead the analyst to drawing an overall conclusion on given topics of concern. There are also C checklists. The C Level checklists reference quarterly information.

**Level 1 Analysis – A (Annual Statement)**

This appendix of the Handbook defines the minimum financial analysis procedures to be completed for all domestic insurers. It relies primarily on FAST ratios, IRIS ratios, Company Profile Reports and selected other general procedures.

**Level 2 Analysis – B (Annual Statement General Checklist)**
This appendix of the Handbook guides the analyst through virtually every section of the insurer's Annual Statement. It is benchmark-oriented in that it incorporates financial ratios, as well as quantifiable thresholds, to assist the analyst in conducting a thorough financial analysis. The text and ratio calculation aspects of the Checklist eventually will be completely automated.

**Quarterly Statement General Checklist – C (Quarterly)**

This appendix of the Handbook guides the analyst through virtually every section of the insurer's Quarterly Statement. Similar to the Annual Statement, it is benchmark-oriented and the text and ratio calculation aspects of the Checklist eventually will be completely automated. It also focuses on significant changes from quarter to quarter.

**Level 3 – Supplemental Checklists**

This appendix of the Handbook describes procedures the analyst may complete when specific concerns surface for a particular insurer or specific aspect of an insurer's financial condition. In contrast to the Annual Statement and Quarterly Statement General Checklists, which are quantitative and benchmark-oriented, the supplemental checklists are more subjective and require judgment on the part of the analyst regarding which procedures to perform and how far to probe.

**Other Checklists**

Other checklists designed to assist the analyst in reviewing other important supplemental filings are also included as appendices. Checklists have been developed for the following areas:
- CPA Reports
- Actuarial Opinion
- Management's Discussion and Analysis
- Holding Company Form B

To view or download the checklist reports available within I-SITE, locate the FAH region on the Financial Reports page. This region is displayed in the image below.

Initially, the Download for Program Automator option is selected. This option allows you to save the report data without the need to view the information. To view the report data, select the View Report option. If while viewing the report you decide to save the information, simply right-click the report data page and select the Save As option from the quick menu. You do not need to return to the Financial Reports page to download (save) the report data.
An example of the Level 1 Procedures Checklist is displayed below using the View Report option.

<table>
<thead>
<tr>
<th>Question Item</th>
<th>Raw Description</th>
<th>Yes/No</th>
<th>Item Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>c</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>d</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>b</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>c</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>d</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e1</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 PREMIUMS AND AGENTS' BALANCES IN COURSE OF COLLECTION AFTER DED DED CEDED REINSURANCE</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 PREMIUMS, AGENTS' BALANCES &amp; INSTALLMENTS BOOKED BUT DEFERRED &amp; NOT YET DUE IN</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 ACCRUED RETROSPECTIVE PREMIUMS AFTER DEDUCTING CEDED REINSURANCE BALANCES</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 FUNDS HELD BY OR DEPOSITED WITH REINSURED COMPANIES</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 BILLS RECEIVABLE, TAKEN FOR PREMIUMS</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 REINSURANCE RECOVERABLES ON LOSS &amp; LOSS ADJUSTMENT EXPENSE PAYMENTS</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 FEDERAL INCOME TAX RECOVERABLE AND INTEREST THEREON</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>e2 GUARANTEE FUNDS RECEIVABLE OR ON DEPOSIT</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

Information on this report includes:

- **Question Number** - refers to the number assigned to a question on the checklist
- **Item** - either a number or letter. Some questions are broken down into several shorter questions (1a, 1b, 1c, etc.). If there are several parts to the same question, refer to the Item designation shown here. In some cases, the first part of the question might be based on the answers given to several of the related questions that follow the original question. You may have to look at several parts of any one question to be able to determine the definitive answer.
- **Row description** - refers to the information on the annual statement pages. Not all lines have a row description.
- **Yes/No** - since many of the questions can be answered with a yes or a no, this information is supplied as a part of the report.
- **NM** - (Not Material) is added to the Yes/No column and to the footer of the Financial Analysis Handbook reports.
- **Item result** - depending on the context of the question, this could be a ratio, a count or a related number.
- **Line number** - if the answer comes from a specific line in the Annual Statement, the line number referenced on that page of the statement is listed here.
- **Item amount** - if the answer contains a specific amount from the annual statement beyond that of the ratio itself, that information will be contained here.

Each report contains answers to most of the checklist questions. The analyst must provide any commentary or substantiation for the information.

**Saving Report Data**

The “Download for Program Automator” option located on the Financial Reports page has been provided to bypass the step of viewing the report and then saving the information. Select the Download option and click the
Submit button associated with the FAH application. The I-SITE Download page will be displayed as shown below.

You have selected to download a report directly instead of using the Save Rows As method (secondary mouse click on the formatted report).

Next, secondary (right) click the hypertext link located on the page. From the quick menu, select Save Link As to save your file.

Within the Save As dialog box, I-SITE will add a standard naming convention to the File name region and insert the required CSV format extension. It is important to remember that Program Automator will only import data that has been saved in the comma space value (CSV) format. When choosing a location (directory) to save the file, specify one you will remember and, since you will be using the saved data with Program Automator, it would be wise to save the file in the PA subdirectory.
You can also download or save report data while viewing by right clicking the actual report page. The image below displays the “Save Rows As” option available from the quick menu.

After selecting the Save Rows As option, the Save As dialog box is displayed allowing you to name the report, assign the format to be used and designate the location where the data will be saved.
When saving report data for Program Automator, you must use the Save File As Type selection of CSV with headers. Program Automator will only import data that has been saved in the comma space value (CSV) format. The filename given to the report data should contain identifying information for the firm, checklist and data year. When choosing a location (directory) to save the file, choose a location you will remember and, since you will be using the saved data with Program Automator, it is wise to store the file in the PA subdirectory.

**(NOTE:** File Names are not limited to 8 characters, but you must have the correct 3-character extension (i.e. .csv) to save the report data.)

**Printing Report Data**

To print a report, secondary (right) click the report data and select the Print option from the quick menu. The document will be printed using standard printer formatting, unless changes are made to your printer setup or margins. An example of a printed report can be seen in the Appendix A of the training manual.

**Program Automator Checklists in I-SITE**

Licensed copies of Program Automator can be obtained by contacting your state’s DP Coordinator. Once you have installed the software, you will need to periodically update the electronic checklists. Copies of the current checklists can be obtained in I-SITE. In the FAH region of the Financial Reports page, there is a hypertext link...
to obtain copies of Program Automator Checklists and/or corresponding Microsoft Word documents. The image below displays the hypertext link available.

Once you click this link, the Financial Analysis Handbook page appears providing additional hypertext links to the appropriate statement type and data years available.

Financial Analysis Handbook

**Program Automator Checklist/MS Word Docs**

<table>
<thead>
<tr>
<th>Life</th>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td>1998 Annual Data Year Checklist/Docs</td>
<td>1998 Annual Data Year Checklists/Docs</td>
</tr>
<tr>
<td>1999 Quarterly Data Year Checklist/Docs</td>
<td>1999 Quarterly Data Year Checklists/Docs</td>
</tr>
</tbody>
</table>

Please send me [feedback](mailto:feedback@fah.org) about FAH and/or Program Automator.

Copyright 1999 National Association of Insurance Commissioners. All rights reserved.
Once you click the appropriate link, you are provided a list of available documentation and/or checklists for the data year being analyzed. The image below listed the top page of the 1998 Life Checklists and Documentation available within I-SITE.

As you scroll further down the page, you can obtain additional checklists and documentation hypertext links as shown in the image below.
The checklists that are followed by the PA File hypertext link can be saved to your hard drive (or network location) for use with Program Automator. Click the PA File hypertext link and select the “Save As” option from the dialog box. It is important to remember that Program Automator displays those checklists that are saved in the appropriate subdirectories of PA. Therefore, if you are saving a Life Checklist, you will need to select the Life subdirectory of the PA. (NOTE: Do not change the file name or the corresponding format extension.)
This lesson is designed to show how to create basic company analysis worksheets using Program Automator based on the Financial Analysis Handbook checklists. The following information includes:

- Creating an Analysis Worksheet
- Entering Data Onto the Checklists
- Attaching Documents and Files
- Printing Materials
- Resuming an analysis
- Modifying an analysis – adding checklists

Getting Started

To start the Program Automator software, locate the Program Automator option from the Start Menu and select the Program Automator icon.

An introductory window will initially appear. To start the program, either click the “OK” button or you can view the tutorial videos provided by Program Automator. These tutorials will help teach you how to use the software. The tutorials were created using Lotus ScreenCam™ and contain text and examples for using the software. (NOTE: No audio is available during the videos.)

The application program window is shown below.
To get started, use the “File” menu. The menu is shown.

The file menu options most used for analysis purposes are:

**File, New Analysis** - used to start a new analysis. You will then be able to attach your worksheets to a new directory and begin entering data.

**File, Resume Analysis** - enter data on worksheets you have already created. This option will be used when you need to work on an analysis that has already been started.

**File, Modify Analysis** - add checklists to an existing analysis.

**File, Delete Analysis** - delete the entire contents of the analysis directory.

**File, Import Ratio Results File to Current File** - imports the data you saved in the CUI Financial Analysis report.

---

**Creating a New Analysis**

If you are creating a new analysis, choose File, New Analysis dialog box is displayed. The image of this box is below.
Using Program Automator

You need only complete the Analysis Name field in the dialog box. You can also change the Date information to confirm to the actual dates of the examination. As you enter the Analysis Name, Program Automator generates a new subdirectory to store the checklists used for this analysis. You may add any general company information by clicking the Permanent Notes button.

Once you have entered the appropriate information, click the “OK” button. The Analysis Group’s Program List dialog box will appear. The image of this dialog box is displayed below.
The top left of the window displays the new subdirectory created when you added the Analysis Name. The Program List section lists any checklist added to the analysis. The File/Section/Segment/Topic region (bottom of the window) lists checklists available, which can be added to the analysis. To locate the available checklists, located the Property or Life subdirectories within the PA directory. Double-click the Property directory and the available checklists will display in the bottom region.

Life and Health checklists all begin with the letters “Lx” (x=the year), followed by a hyphen and the section letter and chapter. Property and Casualty checklists begin with the letters “Px”. Therefore, if you want to analyze the Level One Procedures checklist, click the pxx-a01, then click the “Add” button. Once the checklist is added to the Program List, you are now able to use this checklist.

(NOTE: Adding the checklist to the Program List is only making a copy of the original checklist, which is stored in the C:\PA directory. Changes made when entering data are added to the copy of the checklist and not the original.)
You can add as many checklists as needed to the Program List. For instance, if you only want to do the basic overview of the company, add the Level One Procedures checklist. If you will be working on other checklists, you should add those checklists that apply to the analysis also. (NOTE: It is actually easier to work on multiple checklists if you initially add them to the Program List.) Once you click the “OK” button, the dialog box below will display.

The checklists add to the Program List will now be listed in the Analysis Group dialog box (as shown above). To begin the analysis process for any checklist, select the checklist and click the “Start” button. If you want to revise data within a existing checklist, select the checklist and click the “Cancel” button.

Initially, a dialog box requesting the analyst to enter his or her name will be displayed. This information will be added to the report.
Once a Name is entered, click the OK button. The checklist selected with appear in the window as shown below.

The complete checklist will display. The actual questions are located in the middle of the page with various fields available for each question. The analysts can use each field to provide information pertaining to specific checklist questions.

The Procedure Code fields are provided to allow the analyst a variable coding region. There are no specific entries that need to be made in this field, but it can be used to identify pertinent information or reference specific questions.

The analyst will use the Yes/No and Item Results fields to enter the appropriate information obtained during the analysis process. When the I-SITE FAH report data is imported into the PA Checklist, various Yes/No and Item Results fields will be completed. Specifically, those questions whose results can be answered by Annual Statement data will be completed during this process.

The Attachment field allows the analyst to link other documentation or reports to the checklist questions. These attachments (similar to an e-mail attachment) allow the analyst to reference specific information not directly available from the I-SITE FAH reports or other commonly available data.

**Different Text Views**

You can modify the amount (or portion) of each checklist question displayed. To change the amount of text in the window, click the “Partial Text” button located on the bottom toolbar. The checklist will now show only the first line of each question. This is a toggle button, which now displays as Full Text. Clicking on the “Full Text” button will display the questions in their original state.
Another way to control the amount of text displayed for each question is to use the Detail buttons located on the bottom toolbar. These buttons will increase or decrease the amount of sub-items displayed for each question.

To view all the comments for each question, click the “Show Comments” button. This button is a toggle. When comments are displayed, the button displays as a “Hide Comments” button, which will allow you to turn off the comments. These comments are added either through importing of the I-SITE Report data or can be entered by the analyst by using the “Comment” button located on the bottom toolbar. Remember comments from the I-SITE FAH reports are not displayed until the data has been imported.

The Columns button located on the bottom toolbar provides the analyst with a way of entering data into the available fields (i.e. Procedure Code, Yes/No, Item Result, or Attachment).

Additional information on using the Sign off feature can be obtained by contacting the NAIC Help Desk at 816-374-7231 or via e-mail at help@naic.org. This feature will allow you to enter the names of people who reviewed this information, and can be used for manager or supervisory approval.

**Importing data into Program Automator**

To import the data downloaded (saved) from an I-SITE FAH report into the checklist, select the File menu option, and click the Import Ratio Results File to Current File option. The Open dialog box will display. You will need to locate the saved data file.
Using Program Automator

Select the file saved through I-SITE, then click the OK button. The system crosschecks the report data with the checklist questions available. When the report data is imported into the correct checklist a message will display advising that all the lines matched. Should the message box display any lines not matching or display any lines as empty, you have not selected the correct report data. The message correct message should be similar to the image displayed below.

![Message Example]

The checklist questions should now contain answers within the Yes/No and/or Item Result fields as shown below.

<table>
<thead>
<tr>
<th>Code</th>
<th>Procedure</th>
<th>Yes/No Item Result</th>
<th>Attachment</th>
</tr>
</thead>
<tbody>
<tr>
<td>b</td>
<td>Has surplus increased by more than 25% or declined by more than 15% from the prior year?</td>
<td>Yes</td>
<td>36.304</td>
</tr>
<tr>
<td>c</td>
<td>Are net unrealized capital gains/losses more than 10% of prior year-end surplus?</td>
<td>No</td>
<td>0.67</td>
</tr>
<tr>
<td>d</td>
<td>Is the amount of any individual asset category, other than cash and invested assets, greater than 10% of total admitted assets? If yes, indicate the asset category and amount in the comment section.</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>e</td>
<td>Has any individual asset category, which is greater than 5% of total assets, changed by more than +10-20% from the year? If yes, indicate the asset category, current year-end balance, and the percentage change from the prior year in the comment section.</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>f</td>
<td>Is the amount of any individual liability category, other than losses, LAE and unearned premiums, greater than 10% of total liabilities? If yes, indicate the liability category and</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

To view the comments, click the “Show Comment” button on the bottom toolbar. The comments display below the actual question to which they pertain.
Not every question can be answered from importing the I-SITE FAH report data. For example, a question asking whether or not the company was a priority company last year would not have data available from the report. This data will need to be entered by hand.

The “Columns” button on the bottom toolbar allows you to access specific fields. Select or highlight a question and click the “Columns” button. Within the Columns dialog box, select the appropriate column from the list and type your answer in the field provided. Once you have completed the entry, click the OK button.

Another way to add data is to double-click the field and type the answer in the dialog box provided. For example, if you are answering the Yes/No for question 2, double click the field associated with question 2. The Yes/No dialog box will be displayed as shown below. You are not limited to the words Yes or No for entry in this field.

Most answers to the checklist questions in the Financial Analyst Handbook can be yes or no, or values entered in the fields. For example, you might want to enter a ratio itself in the column of Item Results.
Using Default Values (quick menu)

To select from default values for a given field, right-click the field and select the option from the drop-down list. An example, the default answers for the Yes/No field are Yes, No or N/A). Since the Item Result field does not contain default options, the data entry box will display.

Attaching Other Documents

Some items require more information, or substantiation of the information. Instead of having to enter a lengthy comment or note, you can link the question to a document. Double click the “Attachment” field. Initially, the Title dialog box will display as shown below.

Within the Title dialog box, enter descriptive information related to attachment. The default Title is the current date and time, but you can modify this information. Once the Title (or name) of the attachment is completed, click the “OK” button.

A second dialog box is displayed related to use of templates for your attachment. Since you do not have an RTF template associated with Program Automator, you will click the No option. The Program Automator Text Editor window will be displayed as shown below.
Using Program Automator

Within the Text Editor window, you can type detailed information or insert already created documents into the Text Editor window. You are also able to change the fonts, cut/copy/paste text and spell check the information added to this window.

Should you already have the document created (no need to re-type), you can insert the document as an object into the page itself. Select the Edit menu, and click the Insert option from the drop-down list. Select the option entitled “Object From File” from the Insert sub-menu. The Open dialog box will display as shown below.

As an example, we have selected a letter entitled “ANALYST.DOC”, and clicked the “OK” button. The letter appears within the Text Editor window.
Using Program Automator

The letter is attached the way a graphic image is attached to a document. To return to the checklist in Program Automator, select the File menu option and click the Close option from the drop-down list. You will be prompted to save the contents of the attachment. When you return to the checklist, an icon appearing as a file folder will be displayed in the attachment field as shown below.

Once you have created an attachment for a checklist question, adding another attachment will display the Attachment dialog box shown below. For all subsequent attachments, you will need to select either the New or Modify buttons.

By using the Modify button in the Attachment dialog box, you are able to link one attachment to several questions -- without the need to link and print the document multiple times. If you are creating a new Text Editor document, click the “New” button in the Attachment dialog box.
Using Program Automator

There will be times when you will want to use the same page of an annual statement to document more than one answer -- for example the assets page. To link a second question to same attachment given a different question, click the Modify button in the Attachment dialog box. The Documents window will display allowing you to select the specific attachment to use for another question, as shown below.

Select or highlight the attachment you wish to link and click the Link button located on the bottom. You may link more than one attachment to any one question. When you link multiple attachments, you will display more than one icon in the Attachment column, as shown below.

```
   d. Is the amount of any individual asset category, other than cash and invested assets, greater than 10% of total admitted assets? If yes, indicate the asset category and amount in the comment section.
```

**Modifying an Existing Attachment**

To modify an existing attached document, point at the file folder icon and right click your mouse button. The attached document will be displayed. If there are more than one file folder icons, you can select the appropriate file from the list that appears in the Documents dialog box.

**Hints for Linking Documents**

If you are linking a spreadsheet that fits on one page, you might want to edit the size of the spreadsheet by using the “Edit Picture Size” option on the Edit menu. This allows you to resize any inserted object. The best sizes are 7” long by 5.5” wide. If you are working with larger spreadsheets, you may have to cut and paste the text a few columns at a time. Or, you might try the “Rotate” button on the link screen, which can take advantage of landscape printing.
For long text documents, try to paste the text rather than attach the document. If all else fails, modify your source document to eliminate all formatting and large fonts and then use the Insert function within Program Automator.

Printing a document

The easiest way to print the analysis after data entry has been made is by using the Print menu option. The first option in the drop-down list is “Quick Print”, which will print the checklist and all supporting documentation. The Print menu options are shown below.

Once you select the “Quick Print” option, the Print Destination dialog box will display. You can view the analysis in a Print Preview mode, send it directly to the printer, or save the analysis as another file.

When viewing the analysis in a Print Preview mode, as shown below, you can identify the Company Name, the section or checklist provided in this report, along with the questions and data results. You are able to navigate to the next page by using the “Next” button at the top of the window. (NOTE: You are unable to navigate to the previous page in Print Preview mode. You will need to cancel the Print Preview and return to the Print menu and select the Quick Print option as specified above.)
Using Program Automator

Attached document will be printed (or displayed) at the end of the analysis. Attachments that are linked to multiple questions have numbers assigned them. These numbers refer to the linked file, whether it is a text file written with the text editor, or an inserted object (document or spreadsheet). An example of the quick print is in Appendix A.

### Building Custom Reports

In some cases, you may want to print only selected questions or sections of the analysis. First, you need to select or highlight the questions you want to print, select the Print menu option and click the “Selected Items in Current File” option from the drop-down list.

You can also build your own customized reports of questions containing specific information. You can create a report that lists only those items that have the answer “Yes” in the “Yes/No” column. First, select the Print menu option, then click the “All Items in Current File” option from the drop-down list.

The following image displays the dialog box allowing you to select a customized report (already created) or create a new report. You will click the “New” button on the bottom button bar.
Since this is a new report, you will need to name or title the report, as shown in the dialog box below. Type the report name that you will display in the list of customized reports.

A dialog box will be displayed, as shown below, allowing you to define the attributes of this customized report.
From this dialog box you can include or exclude the following: a Cover Page, Author Credit, Assertions, Permanent Notes, and whether any attachments are displayed at the top of the analysis, as printed documents or just referenced at the end of the analysis. Additional attributes are located by clicking the “More” button located at the bottom of the dialog box.

After clicking the “More” button, the following dialog box is displayed. From this dialog box you can further customize the questions that are displayed by placing an X in the desired boxes. We will create a report that only displays those questions containing the word “Yes” in the Yes/No column.

Place an X in the boxes associated with “Print Items” and “Only those items where the following is true” options. Next, click the “New Paragraph” button (located on the right side) then select the Yes/No button.
located at the bottom of the page. For each column attribute you wish to customize, you will need to add a New Paragraph for each one.

Since we want a report that includes only those questions where the answer is ‘yes’ in the Yes/No column, click the option “the text is equal to:” and type the word “yes” in the field provided, as shown below.

Other options available are to select only those questions where there is text in the field, where is no text in the field, where the text is a specific item, or you can choose to ignore the column information.

The following image displays the Yes report in Print Preview. An example of the Yes Report is in Appendix A.
Resume an Analysis

Should you need to return to an already created analysis to make revisions, review or print, you will need to resume the analysis. To resume work on an already created analysis, select the File menu option and click the “Resume Analysis” option from the drop-down list. The Resume Analysis dialog box will be displayed, as shown below.

![Resume Analysis Dialog Box](image1)

First, you need to locate the file of the analysis within the directory structure in the top left corner. Double-click the file folder and the available checklists will be displayed in the lower portion of the dialog box.

![Checklists Displayed](image2)

Select or highlight the appropriate checklist to work in and click the “OK” button. The checklist will be displayed in the familiar Program Automator window, as shown below. With the checklist displayed, you can continue to develop the analysis.

![Program Automator Window](image3)
After reviewing the Level 1 checklist, you may determine that further analysis and investigation is required. First, you must ensure that the I-SITE FAH report data has been saved. Hard copies of these reports are attached in Appendix A. Next, you will need to add the new checklists to the Program List of your analysis in progress. To add the checklists, select the File menu option and click the “Modify Analysis” option from the drop-down list. From the submenu, select the “Change Program List” option.

Modify Analysis - Adding checklists

After reviewing the Level 1 checklist, you may determine that further analysis and investigation is required. First, you must ensure that the I-SITE FAH report data has been saved. Hard copies of these reports are attached in Appendix A. Next, you will need to add the new checklists to the Program List of your analysis in progress. To add the checklists, select the File menu option and click the “Modify Analysis” option from the drop-down list. From the submenu, select the “Change Program List” option.
Similar to the Resume Analysis, you must locate the file folder of the analysis you wish to modify, as shown below. Click the OK button once you have selected the file.

To add new checklists to the Program List, you must activate the list of available checklists. Locate the checklists within the Directories menu in the top left corner of the dialog box, as shown below.
Once you have the list of available checklists displayed (as shown below), double-click the checklists you need to add to your Program List – similar to creating a new analysis. Once you have added the checklists, click the OK button.

Now, to perform an analysis investigation using those newly added checklists, you must resume the analysis. Select the File menu option and click the Resume Analysis option from the drop-down list. The Resume Analysis dialog box will display allowing you to select from the available checklists in your Program List.

Once you have selected your checklist, click the OK button and the checklist will be displayed. You will need to identify the name of the analyst for each checklist. The following image displays the 1996 Property Reinsurance checklist.
Now, you can import the ratios and modify the checklist information as previously discussed. The following image displays the 1996 Property Reinsurance checklist with imported data.

<table>
<thead>
<tr>
<th>Procedure Code</th>
<th>Yes/No Item Result</th>
<th>Attachment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Determining whether the insurer has a reinsurance program in place that adequately supports its risk profile.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>a. Are Gross Premiums to Surplus (IRIS Ratio 1) greater than 300%?</td>
<td>No</td>
<td>406</td>
</tr>
<tr>
<td>b. Are Net Premiums to Surplus (IRIS Ratio 1A) greater than 300%?</td>
<td>No</td>
<td>106</td>
</tr>
<tr>
<td>c. Are Gross Premiums (from liability lines of business) to Surplus greater than 300%?</td>
<td>No</td>
<td>267.916</td>
</tr>
<tr>
<td>d. Are Net Premiums (from liability lines of business) to Surplus greater than 150%?</td>
<td>No</td>
<td>59.519</td>
</tr>
<tr>
<td>e. Is the largest net amount insured in any one risk (General Interrogatories 13a) greater than 10% of surplus?</td>
<td>No</td>
<td>6.525</td>
</tr>
<tr>
<td>f. Do any concerns exist regarding the provision the company has made to protect itself from any excessive loss in the event of a catastrophe under a workers' compensation policy?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Setting Defaults

The checklists have been created with default questions and or answers, but the analyst can modify any question or answer within the checklists. For example, if a question on a checklist needs to be modified or an additional question needs to be added, you can specify this by using the Modify features within Program Automator.
You can modify any checklist by selecting the Modify button prior to starting an analysis or you can modify the checklist questions by using the Modify Analysis/Edit Program in Analysis option from the File menu, as shown in the images below.

In order to modify a checklist, the window needs to be split into two different regions. The questions are located at the top, while the selected question is located at the bottom. You can use the buttons located in the middle of the window to insert a new question, modify an existing question, re-arrange the layout and position of questions, or delete questions. When you modify a checklist, the changes will only apply to the checklist in this analysis.

You can also modify default options, by selecting the Options menu and clicking the Customize Current File’s Page option from the drop-down list. The page layout selection dialog box will display, as shown below.
As an example, to change the default list of options for the Yes/No column, you can select the “Column Designation” option. Once selected you are able to edit the Yes/No column information.

Select the Yes/No column within the dialog box and the Default Text region will display those items assigned to that column. You can have several default entries for any one column. To keep your changes, you must save the changes made to the file. Remember the changes made to the checklist will only apply to this analysis. All future analyzes will be generated from the original checklist – you are only working with a copy.

Preferences

If you would rather call an analysis something else (for example, you could call it an examination), you can change this by selecting the “Preferences” item from the “Options” menu drop-down list, as shown below.
Within the Preferences dialog box, you can delete the word Analysis located in the bottom field (Refer to working program as), and type the word “Assessment” within the field. Now, everywhere in Program Automator when the word was analysis, it has been replaced by the word Assessment. Additional preferences that can be modified are:

- **Auto-save** - Saves your work at regular intervals
- **Log additions and deletions** - Creates a log file of all changes
- **Break text into pages when printing to file** - Automatically sets page breaks according to the numbers you put into the boxes lines and characters
The attachments to this training guide are in the following order:

- I-SITE Handbook Printout - Level 1 checklist
- Program Automator Quick Print Level 1 checklist
- I-SITE Handbook Printout – Reinsurance checklist
- Program Automator Yes Report Level 1 checklist
- I-SITE Handbook Printout – Unpaid Losses and LAE